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System Requirements:

To ensure the best performance using HotDocs, please note the following requirements for hardware and
software:

HotDocs 2007 Standard Edition
Hardware
e 900 MHz processor (2GHz, recommended)
e 256 MB RAM
e 50 MB hard disk storage
e 1024 x 768 screen resolution with at least 16-bit color
e HP Laserlet printer (for printing graphical forms)
(For the most reliable results, use a PCL-based printer with at least 8 MB RAM. Other types of
printers may or may not print as expected.)
Software
e Microsoft Windows 2000 SP4, Windows XP, or Windows Vista'(32 bit)
e Microsoft Internet Explorer 6.0 or later
e Microsoft Word 2000, XP, 2003, or 2007; or
e Corel WordPerfect 12, X3 or X4°

! Users with Windows Vista 64 bit will need to install HotDocs 2009 Standard and 2009 PDF Advantage to use
IOWADOCS®. HotDocs 2009 installs can be obtained from Technical Support

? Users with Corel WordPerfect X4 will need to install HotDocs 2008 Standard and 2008 PDF Advantage to use
IOWADOCS®. HotDocs 2008 installs are located on the IOWADOCS® 20089 Installation CD.

Technical Support:

Technical Support is available to help you use IOWADOCS" . If you are having difficulties installing or using the
software contact us at the following:

Internet www.iowadocs.net
Email Support support@iowadocs.net
Support Phone (866) 597-6040
Support via fax (866) 202-6572

Support is available from 9:00 A.M. to 3:00 P.M. central standard time, Monday through Friday, if a technician
is not available, please leave a detailed message. To expedite your call, please be at your computer on which
the program is running.
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Introduction:

IOWADOCS is a library of templates related to the practice of law in lowa. These legal forms are created,
endorsed and copyrighted by The lowa State Bar Association. Most IOWADOCS' forms are available in two
formats, Bordered (hpt) and Non-Bordered (rtf). IOWADOCS' does contain state forms that are not to be
altered and are not offered in Non-Bordered (rtf) formats. These forms are clearly marked in the IOWADOCS’
library with “State of lowa Form” labeled in the description of the forms.

Bordered forms (Form Templates) graphical-based electronic form files such as a scanned bitmap
image, Jetform file, Omniform file, etc. A form template contains fixed-space fields, represented by
lines, boxes and check boxes where answers are placed. The bordered forms operate in the Hotdocs
program and cannot be edited. The purpose of the bordered form is to give the parties involved the
assurance that the language of the document is standard, eliminating the need to proof read. Text
cannot be deleted, but must be stricken through. Additional text can only be added where existing text
does not exist. These forms can only be printed on laser printers.

Non-bordered forms (Document Templates) contain the text of the original document plus
instructional scripts for correctly assembling a customized document. After HotDocs assembles a
document, it is placed in the word processor for saving, printing or additional editing. These forms are
identical to the bordered forms in content. The same questions are asked in both formats. Non-
bordered forms are "unlocked" and can be manipulated like any document in word-processing. These
forms should be used if editing is needed or if using inkjet or Dot matrix printers.

With the purchase of IOWADOCS’ you actually have several programs. Each is displayed with a separate icon in
the HotDocs icon group. (HotDocs, HotDocs Filler, and IOWADOCS®)

HotDocs Standard 2007 is a software tool that significantly reduces the time spent generating customized
documents such as contracts, court forms, and legal documents. Using HotDocs, you can transform any word
processor file into an interactive template by replacing the changeable text with HotDocs variables. The next
time you want to generate that document, just use the HotDocs interactive template you've created. The
template prompts you for information and puts the finished document back in your word processor. By adding
functionality and power to your word processor, HotDocs helps you generate customized documents
accurately and efficiently.

NOTE: ISBA does not support training in creation of you own automated templates.

HotDocs PDF Advantage 2007 users the convenience of PDF-based HotDocs templates. After completing
intuitive, logically sequenced interviews to gather required information, HotDocs produces completed forms in
PDF format for maximum portability. Assembled documents can be reviewed using any PDF viewer, including
Adobe® Reader®.

What's more, the included HotDocs PDF Driver lets you convert practically any document (text-based or
graphic-based) into PDF format for convenient emailing, eFiling, or storing for future reference.

HotDocs Filler a program that allows you to fill graphics-based HotDocs form templates (Bordered Forms)
created with HotDocs Pro. It is used to open previously saved IOWADOCS" documents. Once a template is
opened and completed it is detached from the IOWADOCS’ program and saved as a HotDocs form with the file
extension .hpd (HotDocs PDF Document). Hfd files are not recognized by IOWADOCS’ and must be opened
through the HotDocs Filler program.
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Launching IOWADOCS®:

Display the Library

= Todisplay the IOWADOCS’ Library: Choose HotDocs 2007 > IOWADOCS at the Start/Programs menu.
The IOWADOCS’ library window appears.

= To create a shortcut of IOWADOCS on your desktop: Choose HotDocs 2007 > IOWADOCS at the
Start/Programs menu. Right click on IOWADOCS, left click on Copy, right click on the desktop, left
click on Paste.

Finding a Form

You can use the “Find” feature in order to find a form in the library. Most forms have a title with the form
number, which can be used to find forms. Some forms have specific descriptions (HIPAA and state forms)
which the “Find” feature can use to look for a form.

*  To use the find feature, have the IOWADOCS' Library window open.

= At the bottom left locate the Find dialog box, type in your text (i.e. 120)

= Alist will be produced with forms that have that criteria. (i.e. looking for 120 will produce the rtf and
hpd of form 120-General Power of Attorney)

=  During this search, the checkbox will be checked. To go back to the library window, uncheck this box.

Opening or Closing a Folder

= Open folders are represented by this icon a

Pz

= Closed folders are represented by this icon
subfolders that are in it.
= To open or close a folder, Double-click the folder icon.

When a folder is open, you can see the files and

Printing a Form or a List of Forms from the Library Listing

You can print a list of the forms and folders in a library or part of a library. The list will include the titles and
types (template, library, form, etc.).

* To print an IOWADOCS' library

= At the HotDocs library window, go to the File menu, click print library. This will print a very descriptive
list of forms and their properties — in a format that is not very manageable for an end-user.

= Toprintan IOWADOCS' form only, simply right-click on the form you would like to print and select the
option “Print Template”. This will result in the printing of only that form, not the whole listing of the
library.

"Tip

This will print the whole library. To print only certain default folders go to http://www.iowadocs.net/ and click on List of Forms.
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Assembling an IOWADOCS® Form:

) IOWADOCS 2009 Files.hdl - HotDocs 2008 meessiona!Editioni

To start HOtDOCS/ IOWADOCS® File Edit View Template Toels Help
Choose HotDocs 2007 > IOWADOCS at the &) 5 & |48 Asemble ] New Template | Ba B | | | @
® H H
Start/Programs menu. The IOWADOCS = Cjiowapocs 2009, [ Propeties | Preview |
lib ind 3] FASTCASE - Free legal research provided by
Iorary winaow appears. 3] Code of Towa Folder Properties
2 _Suppert Information pe
To start HotDocs, you can also click the [0 Acknowledgment Forms Title: IOWADOCS 2009
@ . [+ 2)Business Law Forms
HotDocs button (=£')in any word processor 1155 Civil Litigation Forms Description:  IOWADOCS@®. An eled
toolbar. This will open and display the #10 Commercial Forms Developed in cooperatt

2 Family Law 1-1-2009
2 Guardianship and Conservatorship Forms
HIZIISBA Manuals

2 Jury Instructions

2 Miscellaneous Forms

IOWADOCS' library window.

Assemble or Fill a Form

You assemble a document by selecting a {2 Powers of Attorney
. . 2 Probate Forms

template and then providing the G160 Real Estate Forms

required variable information. B2 Small Claim Forms

) Workers' Compensation Forms

To Assemble/Fill a document

At the HotDocs library window, select a template.

Click Assemble. The Answer File dialog box appears.

Select the type of answer file needed, then click OK.

If this is a new answer file then it is recommended that you save your answer file first. Go to File/Save

PwnNPE

Answers or click on the E Save Answers icon in the toolbar. (for more information on answer files
please visit the answer file section of this manual). Once named you can use the keyboard shortcut of
Ctrl + S to manually save your current answer file.

5. Answer the dialog questions in the “Interview Tab”, then click Next to advance to each new dialog.

After the final dialog, the End of Interview dialog identifies how many questions haven't been answered. This
dialog also provides options for working with the assembled document. Please see “End of Interview Options”
section for a discussion on options available to you.

Filling a Form Directly

To fill a form directly (not recommended, cannot directly fill a non-bordered form)
1. Atthe HotDocs library window, select a form template and begin assembling the document.
2. Ifit's not selected automatically, click the Document tab. The assembly window changes to show the
form document, and the variable fields.
3. Select a field, then type an answer

Press Tab to move to the next field, or use the mouse to select another field.

"Tip
Some fields have a field wizard—a series of one or more dialogs to help you answer the field when you are filling the form directly. If a
field has a wizard, a wizard button will appear next to the field when its fill control is displayed. Click the button to see the wizard.

If the template author has provided help for a field, a help button may appear next to the field when its fill control is displayed. (The
help button will only appear if the author has enabled it in the template and if the Show Help Buttons check box is selected in
Preferences. For details, click here.) If there is help for the field, you can display it even if the button doesn't appear by clicking the
What's This button in the toolbar and clicking the field.

-7-
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Assembling and Filling Multiple Documents and Forms

You can assemble and fill multiple documents and forms at once by selecting multiple templates and clause
libraries. One document or form will be produced from each selected template or clause library. The Assembly
Options dialog box will appear only once, and all the templates and clause libraries will use the same answer
file.

To assemble and fill multiple documents and forms
1. Display the HotDocs library window.
2. Select each template you want to use. (To select multiple items, hold down the Ctrl key as you click
each one.)

3. Click Assemble.

4. |If you want to use an existing answer file, specify it at the Current Answer File box. (For details, click
here.)

5. Click OK.

NOTE: If you would like to assemble documents in a certain order then you should do the following steps-

1. Start assembling the first form

2. Click on the & to go back to the IOWADOCS" library

3. Double-click on the other forms you would like to assemble in the order you would like to assemble
them. Remembering each time to click on the @ (you should now see the Assembly Queue window.
This shows what forms are “assembling” and forms that are “confirmed”.)

4. To go back to the first form — double click on the form in the Assembly Queue. When you close/finish
with this form the next form will start automatically, with the answer file you used for the other
document.

¥1ip
Don't select more document templates and clause libraries than your word processor can have open at one time.

If you have form templates selected, form wizards will only be used if the Use Form Wizard check box is selected at Preferences. If it is
not, or if the forms don't have wizards, HotDocs will open the forms in Filler. You will need to go back and fill them.

If you have selected only document templates and clause libraries, you will be asked about saving answers when the last document is

done assembling. If you have one or more form templates selected, you won't be asked about saving answers until the last form is
saved or closed. However, when you save a form, it is no longer connected to the answer file, even though other forms may be.
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Using the Jury Instructions in IOWADOCS®

1. Launch the IOWADOCS® program.
2. Double-click on the Jury Instructions directory.
3. Select the type of jury instruction you need.
=t lowalocs 2008
+-12)_Suppart Information

I Acknowledgment Formns
IC2) Civil Litigation Forms
|2 Commercial Forms
IC2) Farnily Law
+-I ) Guardianship and rvatorzhip Forms
= Jury Instructions

é] Civvil Jury Inzstructions Template

é Criminial Jury Instructions Template

-

+

4. Assemble the template you need by double-clicking on it.

Select a new answer file.

6. The Interview Window will have 3 vertical panes (see image below). The first pane is a listing of all the
chapters, second is a listing of available clauses within the selected chapter and the third pane is a
listing of the clauses you have selected.

il

Interview Drocument Preview Comparizon Guestion Summary Angwer Summary
= Crm Chapter 01 ~
= Crm Chapter 02
B Crm Chapter 03 Available Selected:
= Crm Chapter 04 V- *
Crm Chapter 05 =

g C:: Ch:gtz: a6 ,ﬁ 100.1 Statement of Charge
= Crm Chapter 07 ‘fj 100.2 Plea ¢
=1 Crm Chapter 08 ,ﬂ 100,53 Indictment Or Informal Q
=1 Crm Chapter 03 2 100.4 Presumption of Innoce
=1 Crm Chapter 10 El100.5 Evidence @
= Crm Chapter 11 [E) 100.6 Direct/Circumstantial E
=1 Crm Chapter 12 2 100.7 Credibility OF Witnesse
=1 Crm Chapter 13 2 1008 Consideration OF Instn
= Crm Chapter 14 2 1009 Cautionary Instruction
= Crm Chapter 15 ) 100,10 Ressonable Doubt,
B Crm Chapter 16 100,11 Reasonable Daubt - F
B Crm Chapter 17 [E1100,12 Preponderance OF Ev
e P R ] —h .

Far 1

uctio

Pane 1 Pane 2 |« Pane 3
E —— Chapter o) T LU, LS U i ary iiser uCtiD b
<

= Crm Chapter 24
=] Crm Chapter 25 [CIFind:
= Crm Chapter 26
= crm Chapter 27 v ezt D
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7. InPane 1 select the chapter, then in Pane 2 (Available Pane) select the clauses you need, click on the
blue right arrow (or double-click on the clause) to move it to Pane 3 (Selected Pane).
e To select a continuous group of clauses, use the shift key in addition to your left mouse button. To
do this, select (left click once) the first clause you need then find the last clause, hold down the
shift key then left click on the last clause. Now all continuous clauses are selected, as the example

below shows. Click on the blue arrow to add to your selected pane:

| Crm Chapter 01
B]100.1 Statement of Charge

F Instructions

00,9 Cautionary Instruction
|j 100,10 Reasonable Doubt,
|j 100,11 Reasonable Doubt - Re Included Offenses

=]100.1Z Preponderance Of Evidence - Defenses
@ 100,13 Punishment Mok For Jury

e To select a non-continuous group of clauses, use the Ctrl key in addition to your left mouse button.
To do this hold down the Ctrl key then left click on the clauses you would like to include. Now all

clauses are selected, as the example below shows. Click on the blue right arrow to add to your
selected pane:

|\ Crm Chapker 01
@ 00.1 Stakement of Charge

=] 100.3 Indictment Or Information Mok Evidence
=] 100.4 Presumption of Innocence

=]100.5 Evidence

@ 100,86 Direck/Circumstantial Evidence

Ié_ﬂ 100,13 Punishrment Mok For Jur

e You can remove selected clauses in the same manner (above) that you added them. To remove a
clause select it in Pane 3 and use the blue left arrow.
* [£] 1001 sStatement of Charge

=] 100.2 Plea
100.7 Credibility OF Witnesses
2] 1008 Consideration OF Instructions

100.10 Reasonable Doubt

e You can also move clauses after they had been selected in case you inadvertently added one out of
order. Simple click, hold and drag the item to where you need the clause to appear.

Selected:

[Z] 1001 sStakement of Charge
[£] 100.2 Plea

@ 100.8 Consideration OF Instruckions
|£] 100.10 Rflesonable DoI%t.

[£] 100.15 Cutionary Instfictiort DMaipks HalAey [nstrghion
@ 100,14 CAutionary Instruction - Joink Trials
@ 100.17 ionary Instruction - Juror's Notes
ER100.9 Cautionary Instruction

-10 -
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8. When you have finished gathering all your clauses you have two options to finish the form. First you
can click on End of Interview in Pane 1 and then select Send to Word Processor, or for a quicker way
you can click on the Finish button in the lower right corner to send it to your word processor.

Interview Docurnent Preview Comnparigon Question Summary Angwer Summary
=] crm Chapter 08 iadll Crm Chapter 01
=] crm Chapter 09
=] Crm Chapter 10 Bvailable: Selected:
g Erm E:aptef i; =23 Crm Chapter 01 S * ] 100.1 Statement of
tm Chapter = : =] 100.2 Plea
=] Crm Chapter 13 é igg; sztement of by & é 1008 Consideration
= Cm Chapter 14 ) 100.3 Indictment O Inf E] 100.10 Reasonable [
Bl om chapter 15 ﬂ IDDI4 Presurption of In Q 5 100,15 Cautionary I
&1 crm Chapter 16 = e e [E] 100,14 Cautionary T
=] Crm chapter 17 ﬂ 100.5 Ewidence @ =1 40 17 cogtionary T
=] Crm Chapter 15 i
= = = = [Eionary In:
=] crm Chapter 19 Options for finishing
=] Crm Chapter 20
=] crm Chapter 21 th e fo rm
=] Crm Chapter 22 . —_—

=] Crm Chapter 23
=] Crm Chapter 24
=] crm Chapter 25
=] Crm Chapter 26
=] crm Chapter 27
=] Crm Chapter 25
=] crm Chapter 29
=] Crm Chapter 30
=] End of Inkerview

% v

9. Once converted to your word processor edit the document, save and/or print the instructions.
10. Next save your answer file for future use/backup. You have a couple options for saving the Answer

File:

e Option 1:(recommended) you can save the answer file per case type (i.e. auto accident). This way
the next time an auto accident needs to be processed you could use this answer file to fill in the
most common clauses you need and the ones you need to add or remove can be done much
quicker.

e Option 2: you can save the answer file per client (i.e. Jones, Bill). This is useful if you need to
reproduce the exact directions for that client for that particular type of case.

-11 -
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Finished Documents or Forms

Bordered Forms

Until saved or closed the bordered forms are connected to the template and answer file. Changes made to the
form before being saved are also made in the answer file (Figure 1). Once saved, changes to the form are not
changed in the answer file (Figure 2). The file extension .HPD is attached to all saved forms. These saved
forms will not be recognized by IOWADOCS®, so to reopen these forms you must access them thru the
HotDocs Filler program.

Figure 1 Figure 2
4 =N s 4
DI ) )
Form "¢ Ciient SAVED  Client
Answers Form Answers

Non-Bordered Documents

Once IOWADOCS® displays an assembled document in your word processor, the document is a normal word
processing document. You can manipulate this document just like any other word processing document. You
may change your answer or standard document text. Any changes made will not be saved in the answer file.

Once finished with a non-bordered form it can be:
Saved

Printed

Answer File Saved

Saving a Bordered Form

When you save a form, HotDocs closes the current answer file. (You will be asked if you want to save the
answers first.) Any changes you make to the answers in the form once the form has been saved will not be
saved in an answer file.

You will be able to save your documents as and HPD (HotDocs PDF Document) or as a PDF (portable document
format). NOTE: A HPD file is editable, using HotDocs Filler, but the PDF format will not be editable. A PDF
format is convenient for sharing with others that do not have HotDocs, such as clients.

1. Go to the File menu, click Save Document As.

2. Goto the “Save Type as” field and select HPD or PDF (For security options, see “ HotDocs PDF Advantage’).
3. Name your file.

4. Navigate to the directory you would like to save to and click on Save.

A saved form has the file name extension .HPD. It also is not connected to the answer file.
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Printing a Form

Printing a graphical form (hpd) in HotDocs with Acrobat Reader allows you to use a variety of printers. If you
are given the option of using HotDocs PDF driver or the Acrobat Reader driver, always use the Acrobat Reader

option.
To print a form

Click on the Form Document Tab located at the top or bottom of the Assembly window.
On the File menu, click Print. (select Acrobat driver if given the option)

Acrobat Reader will load, make sure paper scaling is not checked or is selected as “none”.
Click on OK.

PN PE

= To print a Question Summary: Click Question Summary Tab then select Print (if you do not see the
Question Summary Tab then go to View Menu and check Question Summary Tab)

= To print an Answer Summary: Click Answer Summary Tab then select Print (if you do not see the Answer
Summary Tab then go to View Menu and check Answer Summary Tab)

End of Interview Options

The “End of Interview” screen is now customizable. As a default you only have one option selected for you.
The option is “View the assembled form document at the Form Document tab...”. This option will open the
“Form Document” tab for you. Below is a list of options you can select to have shown at this screen each time

=
you assemble a document. Click on the ﬂ options button to view all the options available.

End of Interview Buttonz By default the first 4 options and last are selected.
. L . . The other 2 most people might want to have
[v Go tothe first unanswered question in the interview select are: “Save the assembled document in a
[v ‘Wiew the assembled form docurment at the Form Docurnent tab file” and “Save the assembled document as a
PDF”.

[v Sendthe azsermbled test docurment to the word processor

[v Paste the azzembled docurent into the open word processor docurnent Notice that you do not have the option of sending

Copy the ent to the Clipboard the document to Filler. In order to do this select
Bewia e ceaeribles] f ReumaEit i & fE the “Send document to HotDocs Filler” tool in the

tool menu ( D) or select the F11 key on your
keyboard.

Save the azsembled document az a PDE

Cloze this window without zaving the azsembled document
[v Chooze which buttons are displayed on the End of Interview dialog
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Tab Options for Assembling Forms

When you are assembling a form, by default, only the Interview and Form Document (or Document Preview)
are visible tabs. However there are two others that can be displayed: (These tabs are useful especially if you
have forms dictated or filled out by a client because they follow the actual interview that a user fills out.)

Question Summary Tab. This tab allows you to view/print all questions that the interview will ask. It
will give the question and a line for an answer. For those that use dictation of forms, this is an option
to explore.

To view this tab when you assemble a form, open up a form and at the Interview Tab go to
View and select Question Summary Tab. This tab will always be visible.

Answer Summary Tab. This tab is the same as the Question Summary except it will display any
answers you have filled out already. If an answer wasn’t given then it will insert a blank line.

To view this tab when you assemble a form, open up a form and at the Interview Tab go to
View and select Question Summary Tab. This tab will always be visible.
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HotDocs PDF Advantage
PDF Advantage allows you to save (print) files as PDF’s (Portable Document Format) and share with anyone

electronically. You have the ability to save documents as a secure PDF. Secure PDF’s can have passwords,
disallow content copy or printing, and other security options are available.

In IOWADOCS® during the interview: (Save As Option)

1. At the “End of Interview” or “Form Document” tab go to File/Save Document As.

Select “Save As Type” option “PDF File (*.pdf)” and give your file a File Name.

3. To protect the document, select the “Security...” button. If you do not select the security button then
your PDF file can be easily copied or changed. Below is a screenshot of the security options available:

N

PDF Security Settings L2 JES

Security Level

" Mone

™ a0-hit RC4 encroption [campatible with Acrabat 3.2 and later]
fo 128-bit RC4 enciyption [compatible with Acrobat 5.x and later]

Pazzwords

[~ Master password [required to change securnity settings)

Confirr:

[ User password [required to open document)

Confirr:

Printing Content Pratection
" Fully allowed [ Allow content copying and extraction
" Low resolution only [ Allow access for visually impaired

f* Mot allowed

Document Editing

[ Allow content editing

[ Allow pagedevel editing [insert, delete, ratate]
[ Allow annatations

[ Allows Form filling

In HotDocs Filler: (Save As Option)

1. Go to File/Save Document As.

Select “Save As Type” option “PDF File (*.pdf)” and give your file a File Name.

3. To protect the document, select the “Security...” button. If you do not select the security button then
your PDF file can be easily copied or changed. Below is a screenshot of the security options available:

N
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In HotDocs Filler or other applications: (Print Option

In other applications, such as Microsoft Word, Excel, PowerPoint, Print 2/ES8
your e-mail program, or an image editor you can use the HotDocs PDF [ P

Mame: =6 HotDocs river
Drive Printer to save a file as a PDF.

|58 \A_BAR_SERVER'\Dell 17000

l5$ Adobe PDF

Iz Auto Dell 1700n on [A_BAR_SERVE
=9 Fax

Status:
Type:
Where:

1. Open the file. . B 1534 Foor” o S
2. GO tO F|Ie/Pr|nt Print range Copies

i i i ~ Al umber of copies: =
3. Inthe print dialog box select the HotDocs PDF Driver e ||
4. Select Propert|e§ 'for security and other options (see below). e - ﬂﬁ o

Select OK when finished

. + Selected Chart
5. Select Print
6. Name your file and select the directory to save it in. et s

# HotDocs PDF Driver Properties As you can see from the screen shot, there are many options here

for you to choose from. There is not any documentation on these
options so you may need to explore on your own. The tab,
Security, is just like the option listed above — just formatted
differently. Select the options you would like for your document
and when finished select OK.

General | Fort Embed | Compression | Watemark | Security | Destination | about

¥ Protect Document

Open Password:

Retype Open Password:

|
|
Owner Password: |
|

Retype Cwner Password:
Encryption Level: [128bit(5:x Compatible) |
™ Mo Printing
[ No Copying
™ Mo Annotating
™ Mo Modifying
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About Answer Files

When you assemble a document or fill a form, you can save the information you entered for the document or
form (the "answers") in a HotDocs answer file. The answer file stores each answer along with the name of the
variable that uses that answer. The answer file can be used again later to produce the same document or form
without re-entering the answers to the interview questions. You can also use the answer file to assemble

documents and fill forms from other templates that use the same variables.

The best way to organize your answer files depends largely on your type of practice. Some users create one
answer file per client. Others create one answer file per matter. (This method is especially good when you
have multiple matters per client that use the same forms, because it prevents the answers from the current
matter from overwriting the answers from a different matter and the answers from a previous matter from
getting used accidentally in the current matter.) Still other users combine the two methods, creating a pattern
answer file for each client that contains basic client information, and then using the pattern file to copy the
answers into a new file every time they start a new matter for the client.

Answer files have the filename extension .ANS and are stored by default in the default answer file directory.
You can specify a different directory when you create an answer file.

4]
Form #1
Attorney Info
Last Name
First Name
Phone #
Spouse

7
Form #2
Attorney Info
Last Name
First Name
*Street Address
*City
*State
*Zip Code

* = New fields for the answer file

Form #3
Attorney Info

Last Name
First Name
Spouse
*Children
Phone #

NOTE: All 3 of the above forms are using the same answer file.

IOWADOCS® 2009
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Using an Existing Answer File

You can use an existing answer file to assemble a document or fill a form. You can save any changes you make
to the answers in the file, or you can use the answer file but not save your changes.

To use an existing answer file

Open the template you would like to use.

1
2. Atthe Answer File dialog box, click on the Select Answer File button (Eﬁ'*’).
3. Find the Answer File you want to use. Click on Open

4. Assemble the document or fill the form.

To reopen the last answer file you used, click on the drop down menu to select the previous answer files you have used.

You can select an answer file so that it can be used for all documents you assemble and forms you fill until you select another answer
file. Check the “Remember Selected Answer File” box.

Save an Answer File During Assembly

You can save an answer file while you are assembling a document or filling a form.
To save an answer file during assembly

1. Go to the File menu and select Save Answers As... (use Save Answers if you have already saved the
answers once before)

2. Give your answer file a file name (i.e. client name)

3. Hit your tab key — this will take you to the Title field — this will automatically put in your file name for
you.

4. Click on OK

If you are using a new answer file, HotDocs opens an empty, untitled answer file. Give the answer file a name.
If you are using an existing answer file, HotDocs saves the answers you have entered to that file.

About the Answer File Manager

The answer file manager helps you manage your answer files, much like a HotDocs library helps you manage
your templates and clause libraries. The answer file manager is a list of answer file titles. Each title is
associated with an answer file filename. When you select an answer file and click Select, HotDocs uses the
associated file.

Each copy of HotDocs can have only one answer file manager. If you want to separate your answer files, you
can create folders in the answer file manager window.

"Tip

Answer File Manager is disabled if you use windows explorer to save answers.
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Displaying the Answer Library

To display the answer library:

1. Atthe IOWADOCS’ library window, click Tools.
2. Select Answer File Manager (_!'—"J).

Properties Pane View

%2 Answer File Manager

F)New | % | Hadd %) Delete Hrroperties | k?
) Answers
&} 2ar0n, Heny

Almighty, Bruce

Answer File Properties
[#] Billacheck. Ann 1200 E aston Drive

[3) Bilacheck, &nn 234 South Avenue Title:  Aaron, Henry
4] Goodell Holly )
Goadrich, Seott Type: HotDocs Answer File

I [#) Handy, Jane
Heag. Hally
[#) Heqgg, Jim
Henry_Jim
[4] Jones, Andrew
[#) Loote, Jack

File name:  Ikjlk ans

File path: C\Documents and Settings\bheggivy
Documentsibackup answer filesh

Description;  C'\Documents and Settings\bheggiyvy

(2] Loote, Julie Documentsibackup answer files\lkjll ans
Renke_Ruth _
- [A) Smth, ‘Wanen History, Durable Fower of Attorney, Health Care

WanPelt, Jenny
[1) Warner, Jackie

Decisions, #121 Rev. 1/99 August 21,
2003, 14:06

| |

Froperties Cantents

Contents Pane View
%2 Answer File Manager £

|y Mew | X Feroperties | K2
1 Answers
[4]) &aron, Henry

*)add ¥ Delete

Variable Answer Type

) Almighty, Bruce 31|specassessaltdate January 30, 2004 Date
Bilacheck, Ann 1200 Easton Drive atltenancy hegin bebrdaty 14,2004 Hato
Billacheck. finn 234 South Avenue Sijtermdate February 11, 2004 Date

31/trustdate May 22, 1955 Date

-[4] Goodel_Hally

IOWADOCS® 2009

(] Goodrich, Seatt 3__i|wardbir'thdate February 16, 2004 Date
Handy, Jans EE attorney F Number one Mult?ple Chn?ce
[#] Hegg, Holly EE Attorney Number one Mult!ple chn!ce
[#) Hegg, Jim EE attorney Ph Mumber iOne _ Mult?ple Chn?ce
@) Herry_Jim EE attorney fees MC .ﬂ.mlou.nt Estimated Mult!ple Chn!ce
Jones, Andrew = Attyfor Plaintiff Multiple Choice
Loate, Jack §: Client Gender MC Male Multiple Choice

[A] Loote. Julia 25 Consumner credit transives Multiple Choice
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Finding an Answer File

You can quickly find a certain answer file in the library by searching for words in the answer file's title or
description.

To find an answer file

Select the Find check box and type words from the answer file's title or notes in the text box.
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Customizing IOWADOCS’

Adding Text to a bordered form
NOTE: Same process for HotDocs Filler.
1. Open Form to be filled.

Assemble form.

2

3. Go tothe Document Tab to view the actual document and make sure the select tool (h ) is selected

4. Draw field where text is to be inserted. (Simply left click and drag.) Remember text can only be added
where no text exists.

5. Double click on field created and enter text.

Override a Field on a bordered form
You can ‘override’ any field on a document. Doing so will not save this information on the answer file so it is
recommended that the field is not filled in before overriding.

Click on the “Form Document” tab.

Navigate to the field to change.

Click inside the field.

Select “Override Field” from the “Fields” menu option.
Click OK.

Type in the text you would like to appear.

ok wnNeE

To size and position field
NOTE: Same process for HotDocs Filler.
1. Selectfield to be moved or resized.

2. Once selected right click on mouse. (Menu option will appear)
3. Select resize/move
4. Handles or small boxes will appear on field. (These handles are used to move and resize.)
5. The handle in upper left corner of the field is used to move a field.
6. Selecting any other handle will resize the field.
Striking Out Text

NOTE: Same process for HotDocs Filler.
1. Open Form to be filled.
2. Assemble form.
3. Go to the Document Tab to view the actual document and make sure the Select Tool (.t ) is
selected
4. Position field over text to be stricken (create the field a little larger than needed).
5. Go to the Field menu and select Properties.
6. Inthe Properties window check “Strike-Through” (lower right corner).
7. Select the fill tool (L), click inside the field type an “X” or a “-“.
8. Click outside the field. Your field will be inputted with the above type.
NOTE: If you use HotDocs Filler then the tool R is called “Select Fields” and not “Select Tool”.

To get multiple lines to be stricken — give a hard return (type the Enter Key) for one less then the number of lines you need (i.e. If you
need 4 lines to be stricken you need 3 hard returns, do this: type an x, hit enter key, type x, hit enter key, x, hit enter key, type x)

Properties, such as bold, italic, etc. can be changed under the Field/Properties.
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Enlarging and Reducing the Form View

By default, forms in HotDocs Automator display at their actual size.
To enlarge or reduce the form view

View Page Width or view full page
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Change Your Default Word Processor

If you have more than one word processor installed, you can select a default word processor to which you
send an assembled document after you complete a HotDocs interview. This word processor will always be
used, no matter which format the template is in when you select it for assembly. (For example, if you select a
Word template but want the assembled document to be saved as a WordPerfect file, you can select
WordPerfect as the default word processor and HotDocs will convert the assembled Word document to
WordPerfect format.) Note, however, that if you save a document to disk (by clicking the [& save Document
button) without sending it to the word processor first, it will be saved in the same format as the original
template file.

To specify a default word processor
1. Atthe HotDocs library, click the Tools menu then click on the Options button. The HotDocs Options
dialog box appears.
2. Click the Word Processors folder. The right pane changes to show a drop-down list of available word
processors.
3. Click the Default Word Processor drop-down button and select a word processor.

Showing or Hiding Field Backgrounds

You can show or hide the field backgrounds in forms. By default, field backgrounds are visible.

To show or hide field backgrounds

Select the Form Document tab, go to View and select Show Answer Fields. Select again to turn back on
On the View menu in Filler, click Fields.

¥Tip

o
You can also show or hide fields by clicking the View Fields button #0" on the toolbar.

To open a saved bordered form

1. Start HotDocs Filler if it is not already open.
2. On the File menu, click Open.
3. Select the file you want to open and click OK or Open.

If the form was saved as a PDF you can open this form using Adobe Acrobat Reader. Please refer to page 11
“Saving a Form” for more information on the difference of a HPD and PDF file.

#ip
A saved form has the file name extension .HPD.

To create a shortcut of IOWADOCS™ on your desktop:
Choose HotDocs 2007 > HotDocs Filler at the Start/Programs menu. Right click on HotDocs Filler, left click on
Copy, right click on the desktop, left click on Paste.
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Keyboard Shortcuts

Open Ctrl+O

Close Ctrl+F4

Save Ctrl+S

Exit Alt+F4

Undo Ctrl+Z

Redo Ctrl+Y

Cut Ctrl+X or Shift+Delete
Copy Ctrl+C or Ctrl+Insert
Paste Ctrl+V or Shift + Insert
Delete Del

Select All Ctrl+A

Previous Page Alt+PgUp

Next Page Alt+PgDn

Go To Page Ctrl+G

Fit Page to Width Ctrl+H

Zoom In F10

Zoom Out F9

Keystrokes for Symbols

¢ Alt+0162
§ Alt+0167
© Alt+0169
® Alt+0174
° Alt+0176
Ya Alt+0188
% Alt+0189
% Alt+0190
™ Alt+0153
%0 Alt+0137

For a full listing of symbols and their corresponding keystrokes, visit the Manual link from www.iowadocs.net.
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Navigation of IOWADOCS® Library Screen
<% PUBIOWADOCS.hdl - HotDocs 6

Menu Bar—p File Edit View Template Tools Help

Toolbar—» 7 = & | E)assemble  [HfNew Template 2 : ] A B O Al S S B e k2
o
[ -Dacknowledgment Farms Folder Properties
[ Civil Litigation Farms
712 Commercial Forms Title: lowaDocs 2005
120 Family Law e .
@ 5 iarcianiship aid Conservalarship Forf Description: lowaDocs®. An electronic forms product
(21 Miscellaneous Forms of the lowa State Bar Association.
(23 Poweers of Attomey Developed in cooperation with
G120 Probate Forms LexisMNexis. January 2005,
| Library Pane || Properties Pane ||
Forms
< | | 2]

Find Field—p| ™ Find: | j Properties Pl'E""iEE |
For Help, press F1 Preview Tab

Navigation of IOWADOCS® Assembly Screen

Menu Bar
File Edt View NavigatedTook —FEp
9 | New Anzwer File v #) O Oy Z|G) ¥ e E .:-:V Tool Bars
o & ¥
Intervigw Farm Document [ueztion Summarny Anzwer Sum‘mar_l,l/ Various Tab Views
[ Attarney info Attorney info
] Courky in which court is located
T 'E Plankiff Information Mame of attorney A
=] Case number | -
+ Defendent Information [owea Stake Bar Association ml Interview Answer Pane ||
+ Other Information

1 Wha is supplving the inforrnation
] End of Interview B select

Interview
Outline Pane

(Last Bl | [Finish b

Resource Pane
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